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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

AirSpeed 5000 or portions thereof are protected by one or more of the following United States patents: 6,763,523; 6,766,357; 
7,403,561; 7,433,519. Other patents are pending.

AirSpeed 5000 or portions thereof are protected by the following European patent: 1629675. Other patents are pending.

This document is protected under copyright law. An authorized licensee of AirSpeed 5000 may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document 
is supplied as a guide for AirSpeed 5000 Remote Console. Reasonable care has been taken in preparing the information it contains. 
However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not 
accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

Copyright © 2012 Avid Technology, Inc. and its licensors. All rights reserved.

Copyright 2003-2007 of MOG Solutions

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 
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Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.
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The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

This product includes the Warlib library, for which the following notice applies:
Copyright Jarle (jgaa) Aase 2000 - 2009

COPYRIGHT file which is included in the distribution:

warlib is copyright Jarle (jgaa) Aase 2000 - 2009

The warlib C++ Library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public 
License as published by the Free Software Foundation; either version 3.0 of the License, or (at your option) any later version.

The warlib C++ Library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for 
more details.

Portions copyright © 2012 Avid Technology, Inc.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid Remote 
Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Axiom, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, Conectiv, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, Dazzle Digital Video Creator, D-Command, D-Control, Deko, 
DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, 
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, 
DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, 
DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, 
Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame 
Chase, FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE 
HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording 
Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, 
KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, Luna, MachineControl, Magic Mask, 
Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, M-Audio, M-Audio Micro, 
Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray, 
MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar, 
MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF 
Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, 
Personal Q, PET, Pinnacle, Pinnacle DistanTV, Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile 
Media, Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, 

http://www.apache.org/
http://jcifs.samba.org/
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PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, SPACEShift, 
SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, Studiophile, SubCap, 
Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, SYNC I/O, Syntax, TDM 
FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In 
Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, TransJammer, 
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, 
VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either registered trademarks or 
trademarks of Avid Technology, Inc. in the United States and/or other countries.

Footage
Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

News material provided by WFTV Television Inc.
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1 Using This Guide

Congratulations on your purchase of an Avid AirSpeed 5000 Remote Console. 

The AirSpeed 5000 Remote Console is an application that is installed on a PC on your network. 
The AirSpeed 5000 Remote Console is able to connect to one or more AirSpeed 5000 or 
AirSpeed Multi Stream servers on your network. Once connected, you can see the channels and 
inventory on the server(s). Then you can use the AirSpeed 5000 Remote Console to do the 
following:

• Cue and play clips

• Cue and record clips

• Retransfer clips

• Manage clip inventory

• Create Playlists and play the clips out on their associated channels

This guide contains all the installation, configuration, and task-oriented instructions, conceptual 
information, and reference material you need to install, configure and use the Avid AirSpeed 
5000 Remote Console.

This guide is intended for all users, from beginning to advanced.

n The documentation describes the features and hardware of all models. Therefore, your system 
might not contain certain features and hardware that are covered in the documentation.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published:

- If the latest information for your Avid product is provided as printed release notes, they 
ship with your application and are also available online.

If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied on your Avid installation CD or DVD as a PDF document 
(README_product.pdf) and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To 
view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base 
at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

To learn about Avid's new online learning environment, Avid Learning Excellerator (ALEX), 
visit http://learn.avid.com.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/training or call Avid Sales at 800-949-AVID (800-949-2843).

http://www.avid.com/readme
http://www.avid.com/onlinesupport
http://learn.avid.com
http://www.avid.com/training


1 Installing and Configuring the Remote 
Console

The AirSpeed 5000 Remote Console is an application that can be installed on up to ten PCs on 
your network. In addition, each instance of the AirSpeed 5000 Remote Console is able to 
connect to up to ten AirSpeed 5000 servers on your network. 

n The AirSpeed 5000 Remote Console application is pre-installed on the AirSpeed 5000 server by 
default. Do not configure this version of the AirSpeed 5000 Remote Console application.

n In Interplay Production mode, we support up to five (5) devices in the same Studio.

Once configured and connected to an AirSpeed 5000 server (or servers), you can see the 
channels and inventory on the server(s) you are connected to. Then, remotely from your PC, you 
can use the AirSpeed 5000 Remote Console application to do the following:

• Cue and play clips

• Cue and record clips

• Retransfer clips

• Manage clip inventory

• Create Playlists and play the clips out on their associated channels

This chapter describes how to install and configure the AirSpeed 5000 Remote Console for your 
environment.

The following topics are included:

• Standalone Transfer Engine Overview

• AirSpeed 5000 Installation and Configuration Checklist
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Standalone Transfer Engine Overview

When AirSpeed 5000 is configured with a standalone Transfer Engine it operates in 
environments where you have local storage without Interplay. In a Standalone environment, the 
Transfer Engine (TM) application uses FTP functionality to act as the transfer agent between the 
Avid editors and the AirSpeed 5000 Remote Console application.

With a Standalone Transfer Engine configuration, AirSpeed 5000 uses only its own internal 
storage or local Avid editor storage for storing clips and supports playing out to air via drag and 
drop using the AirSpeed 5000 Remote Console. 

In this configuration, clips are visible through Remote Console event listings and can be used to 
drag and drop files in environments where multiple video servers are used. The standalone 
configuration supports playout automation applications such as iNEWS ® Command, DNF 
controllers and other solutions using VDCP or AMS API. 

n Interplay Transfer Engine does not support Studio playout.

n When configured with a Standalone Transfer Engine, the transfer of clips from AirSpeed 5000 
(via the Remote Console) to the Editor must be done manually.

Video servers configured with a Standalone Transfer Engine support the standard features of 
your video server model (AirSpeed 5000) with the exception of the features listed below:

• Avid Studio Playout

• Interplay Capture

• CaptureManager

• Frame Chase™ Editing

• Edit While Capture (EWC) functionality with Avid Editor systems

• H.264 media transfers to the Editor (not for Standalone or Team)

• DNxHD 85/100 support
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For more information, see the following topic:

• Standalone Software Requirements

Configuration Requirements for AirSpeed 5000 Server

Before configuring the AirSpeed 5000 Remote Console for standalone environment, each 
AirSpeed 5000 server that you want to connect to must have been configured with the following:

•  Site-specific settings need to be applied for the AirSpeed 5000 to operate with a standalone 
Transfer Engine.

• A site-specific host name/domain name must have been created for the AirSpeed 5000, 
including an IP address and mask for the network interface.

• The E: drive must be shared with at least Read Only privileges.

Once these requirements are met, and you have installed all of the necessary hardware and 
software for your site, you can configure the AirSpeed 5000 Remote Console for a Standalone 
environment. For more information on specific tasks involved when configuring your AirSpeed 
5000 with a Standalone Transfer Engine, see “AirSpeed 5000 Installation and Configuration 
Checklist” on page 11.

n Prior to proceeding with AirSpeed 5000 configuration, ensure that your AirSpeed 5000 is 
installed and connected as described in the AirSpeed 5000 Setup Guide, and in the AirSpeed 
5000 Administrator’s Guide.
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Standalone Software Requirements

For the AirSpeed 5000 system to function properly in a Standalone environment, it is necessary 
to configure a standalone Transfer Engine. Depending on the Editor software version of 
NewsCutter, Media Composer, or Symphony you are using, you must have a compatible Avid® 
Interplay™ Transfer Engine and Client software version. 

The following table lists the minimum supported Editor and Interplay Transfer software 
versions.

To verify the latest supported software versions, search for the latest AirSpeed 5000 ReadMe on 
the Avid Knowledge Base. 

All of the documentation for configuration is available on the Avid Knowledge Base. This 
documentation assists users in configuration of the standalone Transfer Engine. The Avid 
Interplay Transfer Setup and User’s Guide, and the Avid Interplay Transfer v1.0 Readme are 
available at the top level of the Avid Interplay Transfer CD-ROM. For the latest versions of the 
documentation, see the Knowledge Base.

Software Requirements for the Avid Editing Client

In order for the Standalone AirSpeed 5000 Remote Console to work in a Standalone 
environment, each Avid Editing client must have the following software loaded:

• An Avid editing application (e.g., Media Composer, NewsCutter, or Symphony)

•  A Standalone version of the AirSpeed 5000 Remote Console application

• Avid Interplay Transfer Engine

• Avid Interplay Transfer Client

System Requirements  

Editor Version Interplay Transfer Software

NewsCutter v9.0.4 or later Avid Interplay Transfer Engine v2.5 or later

Media Composer v5.0.4 or 
later

Avid Interplay Transfer Engine v2.5 or later

Symphony v5.0.4 or later Avid Interplay Transfer Engine v2.5 or later
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AirSpeed 5000 Installation and Configuration 
Checklist

The following table provides a checklist of tasks that must be performed on the Avid Editor 
when configuring your AirSpeed 5000 Editing Client in a Standalone Transfer Engine 
environment. 

Depending on your site’s configuration, some tasks are optional.

 Install the AirSpeed 5000 Remote Console application, as described in “Installing the 
AirSpeed 5000 Remote Console Application” on page 12.

 Install the Interplay Transfer Engine, as described in “Installing the Interplay Transfer 
Engine on the Avid Editor (Standalone Mode)” on page 13.

 Connect to an AirSpeed 5000 server, as described in “Connecting to AirSpeed 5000 
Servers” on page 15. 

For Team and Interplay Production modes, after you connect to a server, you can begin 
using the Remote Console, as described in “Getting Started with the Remote Console” on 
page 28

 (Standalone only) There are two methods for configuring the AirSpeed 5000 and related 
software when using a Standalone Transfer Engine (Interplay Transfer Engine). Select 
one of the following methods:

• The AirSpeed 5000 Remote Console (File > Configure Transfer Engine) “Automatic 
Configuration” method, as described in “Automatically Enabling Transfers for 
AirSpeed 5000 Servers (Standalone Mode)” on page 17.

• The “Manual Configuration” method to configure the Avid Interplay Transfer Engine 
Configuration window for a Standalone Transfer Engine, as described in “Manually 
Configuring the Interplay Transfer Engine for a Standalone Environment” on 
page 19.

 (Standalone only) Start the Interplay Transfer Engine on the Avid editor, as described in 
“Starting the Interplay Transfer Engine on the Avid Editor” on page 26.

 (Standalone only) Configure the Standalone settings for the Avid editor, as described in 
“Configuring the Standalone Settings for the Avid Editor” on page 26.

 (Standalone only) Start the Remote Console to verify that your Standalone configuration 
works by connecting to an AirSpeed 5000 server, as described in “Starting the AirSpeed 
5000 Remote Console Application” on page 14, and “Connecting to AirSpeed 5000 
Servers” on page 15.
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Installing the AirSpeed 5000 Remote Console Application

This topic contains information on how to install the correct AirSpeed 5000 Remote Console 
application for your environment. 

n It is important to note that there are two versions of the AirSpeed 5000 Remote Console 

To install the AirSpeed 5000 Remote Console application:

1. On the Avid editor, locate the AirSpeed 5000 Remote Console installation file for your 
environment, and copy it to your desktop. For information on determining which version to 
install

t If your site is configured in an Interplay mode, locate and install the AirSpeed 5000 
Client application called AvidAirSpeed5000RemoteConsoleSetup.exe.

t If your site is configured in a Standalone or Team mode, locate and install the 
Standalone version of the AirSpeed 5000 Client application called 
AvidAirSpeed5000RemoteConsoleStandaloneSetup.exe.

The AirSpeed 5000 Remote Console application will automatically be installed on your 
Avid editor. 

2. Depending on your environment, do one of the following:

t If your site is configured in an Interplay or Team environment, your next step is to 
connect the AirSpeed 5000 server. For more information, see “Starting the AirSpeed 
5000 Remote Console Application” on page 14.

t If your site is configured in a Standalone environment, your next step is to install the 
Interplay Transfer Engine on the Avid Editor. For more information, see “Installing the 
Interplay Transfer Engine on the Avid Editor (Standalone Mode)” on page 13.
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Installing the Interplay Transfer Engine on the Avid Editor (Standalone 
Mode)

If your site is configured in a Standalone mode, the next step is to install the Interplay Transfer 
Engine on each Avid editor.

n These instructions are only a subset of the instructions for installation and configuration of the 
standalone Transfer Engine. See the Avid Interplay Transfer Setup and User’s Guide 
documentation for complete installation and configuration instructions.

n  It is recommended that the XferMgrServer.exe is launched prior to launching the Avid editor to 
avoid having to reconnect the Avid editor to the standalone Interplay Transfer Engine.

If the XferMgrServer.exe is launched following launch of the Avid editor application, the User 
must select the “Transfer”, “Reconnect to server” menu option to reconnect the Avid editor to 
the standalone Interplay Transfer Engine Server.

To install the Interplay Transfer Engine on the Avid editor:

1. Insert the Avid Interplay Transfer CD-ROM and double-click the Launch.exe file. 

The Main Menu page opens.

2. Click Avid Transfer Server.

The Welcome window opens.

3. Click Next.

n Make sure that the FTP services get installed with the Interplay Transfer Engine.

4. Click the applicable country, and click Next.

5. Click Yes to accept the license agreement.

n If you do not accept the license agreement, the Interplay Transfer Engine installation ends 
without completing.

6. The next step is to start the AirSpeed 5000 Remote Console application, and connect to an 
AirSpeed 5000 server. For more information, see “Starting the AirSpeed 5000 Remote 
Console Application” on page 14. 
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Starting the AirSpeed 5000 Remote Console Application

During the installation process, a shortcut to AirSpeed 5000 Remote Console was installed on 
your computer’s desktop. 

n Depending on your configuration, you might have different user requirements. Basically, every 
time a new user is added, you must make sure that they are also added in the appropriate places 
for your environment (Interplay, Shared storage, User’s Page of the AirSpeed 5000 Management 
Console, OS login, Domain). 

For more information on adding and managing users, see the Avid AirSpeed 5000 
Administrator’s Guide, or the AirSpeed 5000 Management Console Online Help.

To start the AirSpeed 5000 Remote Console:

1. Log into Windows 7.

2. Do one of the following: 

t Click on the Avid AirSpeed 5000 Remote Console icon on the desktop.

t Select Start > Programs > Avid > Avid AirSpeed 5000 Remote Console.

- For Interplay Production configurations, the AirSpeed 5000 Remote Console dialog box 
opens for you to type in your user name and password for Interplay. 

- For Standalone and Team configurations, the Avid AirSpeed 5000 Remote Console 
application will automatically launch.
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3. (Option) If you are connected via an Interplay Production configuration, do the following: 

a. Select the Workgroup name from the Workgroup list box.

b. Type the name of the Interplay server that you want to connect to in the Interplay Server 
field.

c. Type the name of the Interplay database in the Interplay Database field.

d. Type your user name in the User field.

e. Type your password in the Password field.

f. Click the Login button.

The Avid AirSpeed 5000 Remote Console application will launch. 

4.  You must now File > Connect... to one or more (up to 10 at a time) AirSpeed 5000 or 
AirSpeed Multi Stream servers.

For more information, see “Connecting to AirSpeed 5000 Servers” on page 15.

Connecting to AirSpeed 5000 Servers

This topic contains information on how to connect to AirSpeed 5000 or AirSpeed Multi Stream 
servers from the AirSpeed 5000 Remote Console. 

Depending on your environment (Standalone, Team, or Interplay Production), you will get 
different “Connect” dialog boxes. 

Once you are connected to a server, you should be able to view Channel and Inventory 
information for that server.

To connect to an AirSpeed 5000 server:

1. On the AirSpeed 5000 Remote Console, select File > Connect... Depending on your 
AirSpeed 5000 environment, one of the following dialog boxes opens:

t For Standalone and Team environments, the Connect to Remote Server dialog box 
opens. If you do not see a server, you must type the host name of the AirSpeed 5000 
server that you want to connect to in the Server Host Name field, and click OK.



AirSpeed 5000 Installation and Configuration Checklist

16

n If you are configured in a Standalone mode, once you successfully connect to an AirSpeed 5000 
server, its host name appears in the Server Host Name list. Therefore, if you ever want to connect 
to that (or any other previously connected to) AirSpeed 5000 server, you can simply select it from 
the list. 

t For Interplay Production environments, the Select Servers dialog box opens. Select a 
server and click OK.

n In order for servers to populate in the dialog box, you must have your user configured properly 
in the User’s Page of the AirSpeed Management Console, as well as in Interplay. Once 
connected to a server, you can view Channel and Inventory information for that server.

n If you are configured in an Interplay Production mode, the servers appearing in the Server Host 
Name list consist of the AirSpeed 5000 servers that are in the Interplay Workgroup that you are 
connected to.

Once connected, Channel and Inventory information for that AirSpeed 5000 server is 
loaded into the AirSpeed 5000 Remote Console with a Server tab just above the 
Inventory panel, showing the host name of that AirSpeed 5000 server.

2. (Optional) Repeat Step 1 to connect to additional AirSpeed 5000 servers.

Channel and Inventory information for additional AirSpeed 5000 servers that you connect to 
appear in the Server tabs just above the Inventory pane. 

n You can connect to up to ten AirSpeed 5000 or AirSpeed Multi Stream servers at one time.
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3. Your next step depends on what environment your site is configured for. 

t For Standalone environments, your next step is to configure the Interplay Transfer 
Engine for a Standalone environment. There are two methods for doing this:

- For information on configuring Standalone transfers using the AirSpeed 5000 Remote 
Console application to automatically configure it for you, see “Automatically Enabling 
Transfers for AirSpeed 5000 Servers (Standalone Mode)” on page 17.

- For information on configuring transfers manually using the Avid Interplay Transfer 
Engine Configuration window, see “Manually Configuring the Interplay Transfer 
Engine for a Standalone Environment” on page 19.

t For Interplay Production or Team environments, assuming you were able to connect to a 
server, you are now ready to begin using the AirSpeed 5000 Remote Console 
application. For more information, see “Getting Started with the Remote Console” on 
page 28.

Automatically Enabling Transfers for AirSpeed 5000 Servers (Standalone 
Mode)

Once the AirSpeed 5000 Remote Console has been launched, you must enable transfers for the 
AirSpeed 5000 Remote Console on the Avid editor to allow communication between it and the 
AirSpeed 5000 server.

To automatically enable transfers for AirSpeed 5000 servers in a Standalone environment:

1. Locate and install the AirSpeed5000RemoteConsoleStandaloneSetup.exe file.

This will install the AirSpeed 5000 Remote Console (Standalone) application on your 
system.

2. Launch the AirSpeed 5000 Remote Console by logging into Windows, and then launching 
the application in one of the following ways:

t Click on the AirSpeed 5000 Remote Console Standalone icon on the desktop.

t Select Start > All Programs > Avid > Avid AirSpeed 5000 Remote Console 
Standalone.

The Avid AirSpeed 5000 Remote Console application will launch.

3.  Connect to the AirSpeed 5000 or AirSpeed Multi Stream server that you want to use. For 
more information, see “Connecting to AirSpeed 5000 Servers” on page 15.
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4. Once connected, select File > Configure Transfer Engine.

The Configure Transfer Engine dialog box opens.

5. Select the AirSpeed 5000 server name that you want to configure from the Select Server list.

The Select Server list displays the most recently used servers.

6. Click Add to add the selected server to the Configured Servers list. 

The Configured Servers list displays the AirSpeed 5000 servers that are configured for use 
by the Standalone Transfer Engine.

7. (Optional) To remove a server from the Configured Servers list, select the server you want to 
remove and click the Delete button.

8. (For MPEG-2 HD (XDCAM) capable systems) To enable Send to Playback (STP) of 
MPEG-2 HD clips, select the compression format you want to use for your transfers from 
the XDCAM STP Format list.

n For all systems that are not capable of MPEG-2 HD (XDCAM) formats, you can leave this field 
blank.

9. Click the Update button to save your changes.

You will be asked to restart the Transfer Engine. Click OK.

10. Manually stop and restart the Transfer Engine. For more information, see “Starting the 
Interplay Transfer Engine on the Avid Editor” on page 26.

At this point, the server is configured for ingest and playback. 

For MPEG-2 HD (XDCAM) servers, a profile is generated that allows you to send to 
playback MPEG-2, 720p or 1080i media. This will be denoted by the 
<AirSpeed5000servername>-HD in the Avid editor upon sending an MPEG-2 HD sequence 
to playback.
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11. Next, you must configure the Standalone setting on the Avid Editor. For more information, 
see “Configuring the Standalone Settings for the Avid Editor” on page 26.

Manually Configuring the Interplay Transfer Engine for a Standalone 
Environment

After installing the Interplay Transfer Engine on the Avid editor, you can manually configure the 
Interplay Transfer Engine to operate in a Standalone environment.

To manually configure the Interplay Transfer Engine for a Standalone Environment:

1. On your Avid editor, select Start > All Programs > Avid > Interplay Transfer 
Configuration.

The Avid Interplay Transfer Engine Configuration window opens.

2. In the Standalone Settings section, ensure that the AAF option is selected.

For more information on the Standalone Settings area, refer to the Avid Unity 
TransferManager Version 2.9.22 Release Notes.

3. Click the Browse button to navigate to the location on your local volume (e.g., C:\), in which 
the media will be transferred to. For example: C:\Avid MediaFiles\MXF\1.

If this directory does not exist, import any supported file into the editor. The directory will 
automatically be created, and then you can navigate to it, and copy and paste the path in the 
“Directory of incoming transfers” field.
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4. In the System Settings area, in the Storage list, ensure that Standalone is already selected. If 
not, select it.

n When Standalone is selected, it also sets the proper buffer size to 8MB.

5. Select the Configure FTP Servers button.

The FTP Configuration dialog box opens.
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6. Select the Add button.

The FTP Server dialog box opens.

7. Complete the following fields as instructed (leave the default in the remaining fields):

a. In the Hostname field, type the name of the AirSpeed 5000 server.

b. In the Username field, type the name of the user.

c. In the Password field, type the password for the user you entered in the Username field.

d. In the Default Directory field, type the path /active/clips.

e. Click OK.
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8. (Option) If you are transferring MPEG-2 HD (XDCAM) clips, click the Add button again to 
create a second profile for XDCAM. Otherwise go to Step 10.

The FTP Server dialog box opens.

9. Complete the following fields for the MPEG-2 HD (XDCAM) profile as instructed (leave 
the default in the remaining fields):

a. In the Hostname field, type the name of the AirSpeed 5000 server.

b. In the Username field, type the name of the user.

c. In the Password field, type the password for the user you entered in the Username field.

d. In the Default Directory field, type the path /active/clips.

e. In the Server Type list box, select OP1A_EXPORT.

f. In the Playback Format list box, select the MPEG-2 HD format that you want to transfer.

g. Click OK.
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10. In the Playback area, add at least one Playback device for handling AVC-Intra, DNXHD, 
and SD clip transfers. 

n If you are transferring MPEG-2 HD (XDCAM) clips, you must add an additional Playback 
device for HD.

11. To add a Playback device, do the following:

a. Verify that the Playback transfers enabled check box is selected.

b. Click the Add button.

The Playback Device dialog box opens.
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12. Do the following: 

a. In the Device name field, type the name of the editor that you are using for FTP transfers 
as follows: 

- If you are transferring AVC-Intra, DNXHD, and SD formats, you must add a 
Playback device name for these formats, by typing it as follows: 

[Name of editor]:6534/[Name of AirSpeed 5000]

- If you are transferring MPEG-2 HD (XDCAM) formats, you must add a second 
Playback device name for HD, by typing it as follows:

[Name of AirSpeed 5000]-HD

b. If you want to allow ancillary data tracks to be transferred, select the Allow Ancillary 
Data Tracks check box.

c. Leave the Enable Playback Catalog Name check box deselected.

d. Click OK.

13. In the Ingest area, make sure that the Ingest Transfers enabled check box is selected.



AirSpeed 5000 Installation and Configuration Checklist

25

14. Click Add.

The Ingest Device dialog box opens.

15. In the Device Name field, type the name of the AirSpeed 5000 server that you are using to 
ingest media, and click OK. 

n Leave all of the other fields blank.

16. In the Dynamically Extensible Transfers (DET) area, do the following:

a. Make sure the DET enabled check box is selected.

b. Make sure the Max. DET push transfers: field is set to 1.

c. Make sure the Max. DET pull transfers: field is set to 0.

17. Click OK to save your changes.

You will get a message saying that “changes will not take effect until the Transfer Engine is 
restarted.”

18. Next, you should start the Interplay Transfer Engine on the Avid Editor. 

For more information, see “Starting the Interplay Transfer Engine on the Avid Editor” on 
page 26.



AirSpeed 5000 Installation and Configuration Checklist

26

Starting the Interplay Transfer Engine on the Avid Editor

If you are configured in a Standalone environment, and the Interplay Transfer Engine is not 
currently running on the Avid editor, you must start it.

To start the Interplay Transfer Engine on the Avid editor:

1. Select Start > All Programs > Avid > Interplay Transfer Engine.

The Interplay Transfer Engine application launches. The title bar should show the words 
“Standalone Mode”.

2. Next, you must configure the Standalone settings for your Avid Editor. 

For more information, see “Configuring the Standalone Settings for the Avid Editor” on 
page 26.

Configuring the Standalone Settings for the Avid Editor

Once all of the required software is installed, you must next configure the Standalone settings for 
the Avid editor.

You should have already configured the Workgroup Properties on the AirSpeed 5000 server. For 
more information, see the topic “Configuring the Avid Service Framework (for Standalone or 
Team Mode)” in the AirSpeed 5000 Administrator’s Guide.

To configure the standalone settings for the Avid Editor:

1. In the Avid editor, do the following:

a. Open the Project Window

b. Click the Settings tab

c. Click Transfer

The Transfer Settings - Current dialog box opens.

2. Select the TMClient.ini tab.

3. In the My Workgroup area, click Edit.

The Edit My Workgroup dialog box opens.

4. In the Server field, type the name of the Avid editor that has the Interplay Transfer engine 
installed.

5. In the Workgroup field, type a name for your workgroup (e.g., “AvidWorkgroup”) that you 
want the AirSpeed 5000 to be associated with, and click OK.

6. Click OK.

7. Next, you are ready to begin using the AirSpeed 5000 Remote Console application. For 
more information, see “Getting Started with the Remote Console” on page 28.
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Verifying your Remote Console is Configured Properly

Once you have configured your AirSpeed 5000 system, you should verify that it is configured 
properly. 

To verify your system is configured properly:

1. Record a clip and verify that the media files are copied to the destination workspace you 
specified. 

2. Depending on the mode you are configured as, do one of the following:

t For Standalone mode, from the AirSpeed 5000 Remote Console, select a clip, and drag 
and drop it to your Editor bin. Launch the Transfer Status tool to make sure the clip is 
transferred to the editor. When it is finished, verify that it plays.

t For Team mode, on the Editor, import the .aaf file and verify that it plays.

t For Interplay Production mode, navigate to the Interplay Transfer window, and drag the 
clip from the Interplay Transfer window to the Editor bin. When it is finished, verify 
that it plays.

3. Depending on the mode you are configured as, do one of the following 

t For Standalone mode, locate the .mxf files in the \AvidMediaFiles\MXF\1 folder.

t For Team mode, locate the master clips\.aaf clips in the “master clip location” on your 
Shared storage.

t For Interplay Production mode, locate the master clips in the Interplay Catalog, and, if 
defined, the Project Path.

4. Edit the clip and Send To Playback (STP) to the AirSpeed 5000 server to verify the full 
round-trip workflow.

In the case of Standalone mode on ingest, and all three modes on Send-To-Playback (STP), 
the Transfer Status window will provide error messages in the event transfers do not 
complete.



2 Getting Started with the Remote Console

The AirSpeed 5000 Remote Console is an application that can be installed on up to ten PCs on 
your network. In addition, each instance of the AirSpeed 5000 Remote Console is able to 
connect to up to ten (10) AirSpeed 5000 or AirSpeed Multi Stream servers on your network. 

Once connected to an AirSpeed 5000 or AirSpeed Multi Stream server (or servers), you can see 
the channels and inventory on the server(s) you are connected to. Then, remotely from your PC, 
you can use the AirSpeed 5000 Remote Console application to do the following:

• Cue and play clips

• Cue and record clips

• Retransfer clips

• Manage clip inventory

• Create Playlists and play the clips out on their associated channels

This chapter describes how to get started with the AirSpeed 5000 Remote Console.

The following topics are included:

• User Interface
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User Interface

The AirSpeed 5000 Remote Console has a graphic user interface consisting of a Main menu, a 
Channels pane containing four (4) channels when connected to an AirSpeed 5000 (six (6) 
channels when connected to an AirSpeed Multi Stream), and an Inventory pane. The following 
illustration identifies the key elements of the AirSpeed 5000 Remote Console user interface.

n  The function and use of these elements is discussed later.
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Main Menu

Located at the top of the application, the Main menu contains the following menus:

• File

• Options

• About

For more information, see each of the menu topics.

• For information on the File menu, see File Menu

• For information on the Options menu, see Options Menu

• For information on the About menu, see About Menu

 Channels Fields  

Number Option Description

1 Main Menu Displays the Main menu items. 

For more information, see “Main Menu” on page 30.

2 Channels Pane The Channels pane contains up to four (4) individual channels, six (6) 
for AirSpeed Multi Stream servers. Each channel represents a channel 
on the active AirSpeed 5000 server that you have connected to. 

For more information, see “Channels Pane” on page 33.

3 Inventory Pane The Inventory pane is a list view of an AirSpeed 5000 server’s 
inventory. You connect to an AirSpeed 5000 server using the File > 
Connect command. 

For more information, see “Inventory Pane” on page 37

4 Filter Controls Enables you to filter clips in a variety of ways.

For more information, see “Filter Controls” on page 40.

5 Status Bar Enables you to view system status. 

For more information, see “Status Bar” on page 41.
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File Menu

The File menu contains the following submenus. Each is described in the following table:

File Submenus  

Option Description

Connect Enables you to connect to an AirSpeed 5000 server to view Channels and 
Inventory. 

For more information, see “Connecting to AirSpeed 5000 Servers” on 
page 15.

Configure Transfer 
Engine

(Only available for 
Standalone version of the 
Remote Console)

Enables you to select the AirSpeed 5000 server you want to configure. 

For more information, see “Automatically Enabling Transfers for 
AirSpeed 5000 Servers (Standalone Mode)” on page 17.

Exit Closes the AirSpeed 5000 Remote Client application and exits to the 
Windows desktop.
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Options Menu

The Options menu contains the following submenus which are described in the following table:

Options Submenu  

Option Description

Flashing Play/Rec The behavior of the Flashing Play/Rec menu option is as follows:

• If checked, when playing, the Play and Channel Status buttons will 
flash green. When recording, the Record and Channel Status buttons 
will flash red.

• If unchecked, when playing, the Play and Channel Status buttons will 
stay solid green. When recording, the Record and Channel Status 
buttons will stay solid red.

View Playlists The behavior of the View Playlists menu option is as follows:

• If checked, the application will be in Playlist View mode. The 
Channel pane is vertically aligned along the left hand side of the 
screen. Playlists (depending on whether you have created any 
previously, some might be empty) appear to the right of each channel.

• If unchecked, the application will be in its normal state.
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About Menu

The About menu contains the following submenus. Each is described in the following table:

Channels Pane

The Channels pane contains up to four individual channels for AirSpeed 5000 servers (up to six 
for AirSpeed Multi Stream MPEG-2 HD models). Each channel represents a channel on the 
active AirSpeed 5000 or AirSpeed Multi Stream server that you have connected to.

n If your system is configured for DNxHD 185/220, or if you have a 2-channel model server, you 
will only see two (2) channels.

n You can click and drag a clip from the Inventory pane to a channel Precue area or Load area. If 
you drag it to the Precue area, the clip gets precued to play. If you drag it to the Load area, the 
clip is loaded and plays. For more information, see “Playing Clips” on page 61.

About Submenus  

Option Description

Version Selecting About > Version displays the copyright notice and software 
version number.

Help Selecting About > Help brings up the Online Help.
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Each Channel has the components shown in the following figure.
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 Channels Fields  

Number Option Description

1 Channel ID Displays the channel number. 

2 Channel Format The format for the channel.

3 Channel Status The following channel statuses are available:

• IDLE – There is no active clip.

• PAUSED – The active clip is paused.

• PLAYING – The active clip is playing.

• SHUTTLING – The active clip is shuttling.

• JOGGING – The active clip is jogging.

• VARIPLAY – The active clip is variable playing.

• RECORDING – The active clip is recording.

• CUED – The active clip is cued for Playback or Record.

• UPDATING – Indicates that you switched from one 
server to another, and there is a delay in getting status 
information for the new view. 

• DONE – The active clip was played to the end.

• ERROR – The last cue operation failed (will stay in this 
state until another cue is issued).
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4 Current Video ID Displays the video ID of the current clip. This field is also 
where you can drag a clip to play it. 

For more information, see “Cueing and Playing Clips 
Directly from the Current Video ID Field” on page 61.

5 Clip Name Displays the clip name of the actively playing or recording 
clip. 

You can also change the name of a currently recording clip 
by clicking the field to enable it for editing, and then typing 
the name directly in the field.

n Do not include these characters (* | “ : < > ? / . \ ) in 
the Clip Name field.

n If these characters (* | “ < > ?) are used in the Clip 
Name field, they will be translated to (_). The ( / and \ 
) characters behave as folder level separators.

6 Time Code / Elapsed Displays the time code or elapsed time of the currently 
loaded clip. 

The default is Time Code. 

To toggle (change) the field name display between Time 
Code and Elapsed, right-click on the field, and select the 
name that you want to display from the menu.

7 Duration / Remaining Displays the duration or time remaining of the currently 
loaded clip.

The default is Duration. 

To toggle (change) the field name display between Duration 
and Time Remaining, right-click on the field, and select the 
name that you want to display from the menu.

You can also change the duration or time remaining of a 
currently recording clip by clicking in the field to enable 
editing, then typing the duration directly in the field. If you 
reduce the duration or time remaining to less than what has 
already been recorded, the clip will stop recording.

 Channels Fields  

Number Option Description
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Transport Buttons

The Transport buttons are the buttons towards the bottom of each Channel. They are used to play, 
record, pause, eject, and recue the currently loaded clip.

8 Transport buttons The Transport buttons are used to manipulate the video. 
Buttons included are the following:

• Recue

• Pause

• Play

• Record

• Stop

For more information on the Transport buttons, see 
“Transport Buttons” on page 36.

9 Next Video ID The Video ID of the next (cued) clip. 

For more information on cueing clips, see “Cueing and 
Taking Clips via the Next Video ID Field” on page 62.

 Channels Fields  

Number Option Description

Transport Buttons  

Button Name Description

Recue Brings you back to the beginning of a clip that is playing in the Current Video 
ID field.

Pause Pauses the currently playing clip.

Play Plays the clip that is loaded in the Current Video ID field.

Record Records a clip. The Recording clip uses the ID in Clip ID field if one is 
specified.
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Inventory Pane

The Inventory pane, shown in the following illustration, is a list view of a server’s inventory. You 
can connect to any AirSpeed 5000 server using the File > Connect command. 

If you are connected to more than one server (AirSpeed 5000 or AirSpeed Multi Stream), you 
can toggle between the active server, and another server that you are connected to by clicking on 
the Server tab just above the Inventory pane for the server that you want to work with. The 
currently active server’s inventory displays in the Inventory pane.

n When you connect to multiple AirSpeed 5000 or AirSpeed Multi Stream servers, they appear as 
additional tabs just above the Inventory pane.

n The tab for the active Server (the one you are currently viewing inventory for) is highlighted.

Stop Ejects a playing, recording, cued or paused clip from the channel. 

Transport Buttons (Continued)  

Button Name Description
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Inventory Pane Fields  

Option Description

Name The name of the clip. 

Video ID The unique video ID of the clip.

Duration The duration of the clip.

In The IN timecode of the clip.

Out The OUT timecode of the clip.

Creation Date The date the clip was created.

Protected An identifier denoting whether this clip is protected from deletion. For 
information on protecting clips, see “Protecting or Unprotecting Clips 
from Deletion” on page 70.

Format The format of the clip.

Transfer Status The transfer status of the clip. Options are: 

• Transfer Done 

• Transfer Error

• Transfer Paused

• Transferring Out

• Transferring In

• Transfer Request

• Ready to Transfer

• Recording

Head Frame Displays the head frame of the clip. For more information, see 
“Headframes” on page 39

Original For subclips, this field lists the Video ID of the master clip from which 
the subclip’s media is associated with.
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If you want to change the order of fields in the Inventory window, click, see “Changing the Sort 
Order of Clips” on page 55. 

Headframes

The term “Headframe” refers to an identifying frame of video associated with each clip in the 
database of an AirSpeed 5000 or AirSpeed Multi Stream server. Headframes might have 
additional symbols on them to identify the kinds of files they represent.

Proxy Status Displays the status of the Proxy for this clip. Options include:

• No Proxy

• Requesting

• Transcoding

• % Done

• Completed

Inventory Pane Fields (Continued)  

Option Description

Headframe Icon Descriptions  

Icon Description

Green film icon upper right corner: This image is a clip residing on 
another AirSpeed 5000 or other clip server. 

n If the film icon appears RED, the clip will not play.

Green film icon with shortcut arrow: This clip is a sub-clip of the 
original. It contains instructions to play a portion of the original clip as 
edited.

Green film icon with curved arrow: This clip has been set for loop play 
(not available for MPEG-2 HD clips).

A yellow rectangle in the lower left corner of the clip indicates a 16:9 
1080i clip format.

A blue rectangle in the lower left corner of the clip indicates a 16:9 720p 
clip format.

A magenta rectangle in the lower left corner of the clip indicates an 16:9 
SD clip.
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Filter Controls

The Filter Controls area displays beneath the Inventory panel.

The fields in the Status bar example indicate the following:

Indicator Description 

Filter Enables you to filter on a clip name or video ID. 

For more information, see “Filtering on a Clip Name or Video ID” 
on page 58.

Clip Source Enables you to filter clips based on if they were recorded from 
baseband (locally) or transferred from a Send to Playback 
sequence.

• If the Recorded check box is selected, the filter will only show 
clips that meet the filter criteria and were recorded locally.

• If the Transferred check box is selected, the filter will only 
show clips that meet the filter criteria and were transferred.

• If both or neither the Recorded and Transferred check boxes 
are selected, there is no effect on the filter.
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Status Bar

The Status Bar displays across the bottom of the Remote Console application window.

The fields in the Status bar example indicate the following:

Indicator Description 

Clip Count Displays the number of clips on the selected (active) AirSpeed 
5000 or AirSpeed Multi Stream server.

Reference Status Displays the reference status. Options are: 

• Ref OK - The reference signal is working properly.

• ! NO REFERENCE - The system cannot detect a reference 
signal.

• ! REFERENCE UNLOCKED - The reference is unlocked.

•  ! WRONG REFERENCE TYPE - The system detected that 
you have the wrong reference type.

n This occurs when you are supplying an SD Reference 
(which is expecting Blackburst) to an HD based database 
(which is expecting Tri-level) or vice versa.

System Time (11:32:36) Shows the current time.

Free Space (1,576,976 (% 82 
Free))

The amount and percentage of free space on the AirSpeed 5000 or 
AirSpeed Multi Stream server that holds this Inventory.

Connection Status Displays the connection status. Options are:

• CONNECTED - Indicates that the server is connected to the 
AirSpeed 5000 Remote Console.

• NOT CONNECTED - Indicates that the server is not 
connected to the AirSpeed 5000 Remote Console.
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View Playlists Mode

The View Playlists mode is a part of the AirSpeed 5000 user interface that shows Playlists for 
each Playout channel you have on the selected AirSpeed 5000 or AirSpeed Multi Stream server. 
The Remote Console Playlist enables you to easily create Playlists and execute some basic tasks 
using these Playlists. 

n A Playlist can support up to 24 hours of video, and up to 1000 clips.

You can enable or disable the View Playlists mode at any time, by selecting Options > View 
Playlists.
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Playlist Information Bar

This topic contains information on the Playlist Information bar in the Remote Console Playlist 
View.

Option Description 

The Playlist name (gray box on the left) is used to type in a name 
for the Playlist. The menu to the right of this gray editable field 
contains the following items:

• Open - Loads an existing Playlist.

• Save - Saves the currently loaded Playlist.

• Clear - Clears the currently loaded Playlist.

• Take Control - Takes over control of a Playlist from another 
user.

Select the Cue button to automatically cue the highlighted clip in 
the Playlist. If no clip is highlighted, selecting the Cue button cues 
the first clip in the Playlist. 

For more information, see “Cueing a Playlist” on page 78.

To cue an individual clip, you can also highlight the clip you want 
to start playing from, and right-click. Then, select Cue from the 
menu.

For more information, see “Cueing From a Specific Clip in the 
Playlist” on page 78.

Enables you to toggle the Playlist between Loop On and Loop Off.

• If the button is Green, it indicates Loop On.

• If the button is Grey, it indicates Loop Off.

For more information, see “Setting Loop Behavior in the Playlist” 
on page 76.

Duration The Duration of the entire Playlist.

Remaining The remaining duration in the Playlist. The value in this field 
indicates the time remaining to play from where a clip in the 
Playlist is currently cued or playing.
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Playlist

This topic contains information on the Clip Information pane in the Remote Console Playlist 
View.

n All Playlist column headings can be reordered by clicking on a column heading and dragging 
and dropping it to the desired location.

You can resize column headings by clicking on the edge of a heading and dragging it.

Option Description 

Clip # Indicates the clip position of the clip in the current Playlist. 

If you want to reorder a clip in the Playlist, you can drag and drop 
a clip to the desired location in the Playlist. 

For more information, see “Reordering Clips within the Playlist” 
on page 76.

Name The name of the clip.

Video ID The Video ID of the clip.

In Lists the Mark IN timecode of the clip.

For more information, see “Modifying Mark In/Mark Out Points 
for Clips in the Inventory Pane” on page 65.

Out Lists the Mark OUT timecode of the clip.

For more information, see “Modifying Mark In/Mark Out Points 
for Clips in the Inventory Pane” on page 65

Duration The total duration of the clip.
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Follow • If the Follow check box is selected (Orange check mark) for 
this clip, the clip will automatically play if it is the next clip 
cued.

• If the Follow check box is not selected for this clip, the Playlist 
will stop play when it gets to this clip. You need to manually 
press the Play button, Spacebar, or F12 to continue playout on 
the channel.

Status Describes the status of the clip. Options are: 

• Online - A clip is considered to be “Online” when the media is 
present in the Inventory pane, and the video standard is the 
same as the associated channel.

• Offline - A clip is considered to be “Offline” when the media is 
missing from the Inventory pane.

• Cued - The clip is cued to play. When a clip is cued, the row 
appears highlighted yellow.

• Playing - The clip is playing. When a clip is playing the row 
appears green.

•  Unplayable - A clip is considered “Unplayable” when its 
video standard is different than the associated channel, it is in 
the wrong format, or it is less than 10 seconds in length (too 
short). When a clip is un-playable, the row appears grey and 
the text is bold.

n Unplayable and offline clips will be skipped when the 
previous clip has finished playing. The following clip will 
play if Follow is selected.

Option Description 
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Clip Properties Panel

This topic contains information on the Clip Properties Panel in the Remote Console Inventory 
View.

To access the Clip Properties Panel, right-click on a clip in the Inventory Panel, and select Clip 
Properties from the menu.

n The Clip Properties panel is only available when connected to an AirSpeed 5000 server.

Option Description 

Clip ID Displays the Video ID of the clip.

Timecode Source Identifies the Timecode source for this clip. Options include:

• None

• TOD (Time-of-Day)

• ATC/VITC

• LTC

Codec The compression method by which clips are stored. The values 
listed in this field are set in the Record Templates page of the 
AirSpeed 5000 Management Console. What displays in this field 
varies depending on what was configured there.

Bitrate The data rate, in Mbit/s, at which clips are recorded. This data rate 
depends on the codec type used.

The rate shown in the field applies to the clip. 

Aspect Ratio Displays the video aspect ratio.

Base Timecode Displays the base timecode used by the clip for time calculations.

For more information, see “Viewing Clip Properties and 
Modifying Clip Behavior” on page 60.

Proxy Clip Displays the status of the Proxy clip (if available).
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Looping Displays the looping parameters for the clip. Options are:

• Don’t Loop

• Loop - If selected, you can select the number of times you 
want it to loop in the times field.

• Loop forever - If selected, the clip will loop endlessly.

If Loop or Loop Forever are selected, you can also set a position in 
the clip where looping starts using the Loop In field.

n This functionality is available for SD , AVC-Intra, and 
DNxHD clips only. You cannot loop MPEG-2 HD clips.

For more information, see “Viewing Clip Properties and 
Modifying Clip Behavior” on page 60.

Loop In The position in the clip where looping starts. You can change this 
position by typing directly in the field.

For more information, see “Viewing Clip Properties and 
Modifying Clip Behavior” on page 60.

Audio A1-A8 Indicates the name of the audio stream. Streams 5-8 are for HD 
only.

Below the name is the source type for the audio portion of the clip. 
The options are:

• Discard - Passes the audio without compression

• PCM-16 Bit

• PCM-24 Bit

• AC-3

• Dolby-E

n You must have at least one stream selected (not discarded).

Option Description 
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Proxy Viewer

This topic contains information on the Proxy Viewer. The Proxy Viewer is accessed by 
right-clicking on a clip in the Inventory pane, and clicking View Proxy.

However, in order to generate Proxy clips, and view them in the AirSpeed 5000 Remote Console 
Proxy Viewer, the following must be done:

• An H.264 Proxy Encode license must be activated on your server.

• The Proxy Enabled check box must be selected in the Record Templates page of the 
AirSpeed 5000 Management Console.

n If the Proxy Viewer is hidden from view by another window, minimize and maximize the AirSpeed 
5000 Remote Console application to bring it back on top.

n The Proxy Viewer is only available when you are connected to an AirSpeed 5000 server. In 
addition, the AirSpeed 5000 Remote Console application must be installed on a Windows 7 
Operating System.
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Playback Controls allow you to play the clip to verify your settings. The following table 
describes the function of the Playback Control buttons.

Proxy Viewer Buttons  

Button Name Function

Go to Start Moves you to the start of the clip.

Go to End Moves you to the end of the clip.

Pause Pauses the currently playing clip.

Play Plays the clip.

Step back one 
Frame

Moves the clip to the previous frame.

Step Forward one 
Frame

Advances the clip forward one frame.

Set Mark IN Sets a Mark IN at the location in which the clip is stopped at.

Set Mark OUT Sets a Mark OUT at the location in which the clip is stopped at.

Create Subclip Creates a subclip based on the master clip you are previewing. The 
subclip will reflect the current Mark IN and Mark OUT points that 
have been set for the clip. For more information, see “Viewing 
Proxy Clips” on page 67.

Create Headframe Sets the headframe image to what is currently showing in the Proxy 
Viewer monitor.

Go to Mark IN Moves you to the Mark IN point of the clip.

Go to Mark OUT Moves you to the Mark OUT point of the clip.



User Interface

50

The following table describes the field and options available on the Proxy Viewer.

Go to Headframe Moves you to the headframe set point of the clip.

Proxy Viewer Buttons (Continued)  

Button Name Function

Field/Option Description 

Timeline Scrubber Moves you forward and backward through the full length of the 
clip.

Current Timecode Displays current clip position.

Video ID Displays the name of the clip.

Length Displays the length of the clip.

Audio AirSpeed 5000 records up to eight (8) stereo pairs of audio for HD 
formats, and up to four (4) stereo pairs of audio for SD formats.

This allows you to record and play back two different sound tracks 
for programs broadcast in two different languages. For the purpose 
of editing a clip, use the menu to select the stereo pair.

Duration Displays the duration of the clip.
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Right-Click Menus

The following right-click menus are available in the AirSpeed 5000 Remote Console.

Right-Click Menu Description 

Right-clicking on a clip in the Inventory pane displays a menu, allowing 
you to:

• Toggle Delete Protect - Protects this clip file from being deleted.

See “Protecting or Unprotecting Clips from Deletion” on page 70.

• Transfer to Shared Storage - Transfers this clip to storage and checks it 
into Interplay. This option is only available in an Interplay Production 
environment.

See “Transferring Clips to Shared Storage” on page 71.

• Create Subclip - Creates a subclip in a new row in the Inventory panel. 
The subclip is based on the media in the master clip. You can then set 
Mark Ins and Mark Outs based on the master clip.

See “Creating Subclips” on page 65.

• Create Proxy - (Only available if connected to an AirSpeed 5000 server 
with an H.264 Proxy Encode license activated, and existing Proxy 
media available) Creates a proxy of the clip. As the proxy is created, 
the status appears in the Proxy Status column of the Inventory panel.

See “Viewing Proxy Clips” on page 67.

• View Proxy - (Only available if connected to an AirSpeed 5000 server 
with existing Proxy media available) Selecting this option, opens the 
Proxy Viewer to view a proxy of the clip. You can then set Mark INs 
and Mark OUTs based on the master clip. In addition, you can create a 
subclip based on the media in the master clip in a new row in the 
Inventory panel.

n If this option is grayed out, it might be because the user/password 
on the Remote Console client either does not exist, or does not 
match the user/password that is on the AirSpeed 5000 server.

See “Viewing Proxy Clips” on page 67.

• Clip Properties - (Only available if connected to an AirSpeed 5000 
server) Selecting this option displays the Clip Properties panel, 
allowing you to view and modify some clip properties, including the 
ability to modify Looping behavior.

See “Viewing Clip Properties and Modifying Clip Behavior” on 
page 60.
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Right-clicking on any column heading in the Inventory pane displays this 
menu, allowing you to show or hide selected columns. 

Clicking “Hide This Column” hides the column that you right-clicked on 
in the Inventory pane. 

If the option next to a column heading is selected, the column will appear 
in the Inventory pane. If it is not selected, it will not appear in the 
Inventory pane. 

Click the More button to open a dialog box to select or deselect multiple 
columns that you want to show or hide in the Inventory pane.

If you want to view the master clip name from which a subclip’s media is 
associated with, you must select the Original column.

See “Showing or Hiding Columns in the Inventory Pane” on page 57.

Right-clicking on a clip in the Playlist will display this menu. 

• Cue - Selecting Cue automatically cues the highlighted clip. The row 
for the cued clip appears highlighted yellow.

See “Cueing From a Specific Clip in the Playlist” on page 78.

• Remove Clip - Deletes the highlighted clip from the Playlist.

See “Deleting Clips from the Playlist” on page 77.

• Enable Follow - Highlighted clips will all be enabled to play next in the 
Playlist.

• Disable Follow - Highlighted clips will all be disabled to automatically 
play next in the Playlist.

See “Setting the Follow Behavior for Clips in the Playlist” on page 77.

Right-Click Menu Description 



3 Working with the Remote Console

Once you have installed and configured your AirSpeed 5000 Remote Console, and connected to 
one or more AirSpeed 5000 or AirSpeed Multi Stream servers, you are now ready to use the 
Remote Console to do the following:

• Cue and play clips

• Cue and record clips

• Retransfer clips

• Manage clip inventory

• Create Playlists and play the clips out on their associated channels

n In Interplay Production mode, we support up to five (5) devices in the same Studio.

For more information on working with the Remote Console, see the following topics:

• “Working with Clips” on page 54

• “Working with Playlists” on page 72

• “Performing an Edit While Capture (EWC) with Drag and Drop” on page 80

• “Performing an Edit While Capture (EWC) with Auto Transfer” on page 81

• “Importing .AAF Files into the Avid Editor (Macintosh Team Mode)” on page 84



Working with Clips

54

Working with Clips

This topic contains information on how to work with clips in the AirSpeed 5000 Remote 
Console.

The following topics are included:

• “Selecting Clips” on page 55

• “Changing the Sort Order of Clips” on page 55

• “Showing or Hiding Columns in the Inventory Pane” on page 57

• “Filtering on a Clip Name or Video ID” on page 58

• “Playing Clips” on page 61

• “Recording Clips” on page 62

• “Creating Subclips” on page 65

• “Working with Proxy Clips” on page 66

• “Deleting Clips” on page 70

• “Protecting or Unprotecting Clips from Deletion” on page 70

• “Transferring Clips to Shared Storage” on page 71

• “Transferring Clips to an Avid Editor (Standalone Mode)” on page 71

• “Working with Playlists” on page 72

• “Basic Playlist Operations” on page 74

• “Working with Clips in the Playlist” on page 76

• “Working with Playlists” on page 72

• “Performing an Edit While Capture (EWC) with Drag and Drop” on page 80

• “Performing an Edit While Capture (EWC) with Auto Transfer” on page 81

• “Importing .AAF Files into the Avid Editor (Macintosh Team Mode)” on page 84
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Selecting Clips

You can select clips in the Inventory pane for playing, cueing, deleting, or transferring to 
Interplay.

You can also select multiple clips for deletion or transfer to Interplay. There are two methods for 
selecting multiple clips.

To select a single clip:

t Simply click on a clip you want to select.

To select individual non-consecutive clips

t Ctrl+click and select individual non-consecutive clips.

To select a series of clips

t Shift+click and select multiple consecutive clips.

Changing the Sort Order of Clips

This topic contains information on changing the sort order of clips based on a single column of 
data in the Inventory Pane.

To change the sort order of clips:

1. To sort on a single column heading, click on the column heading to sort by at the top of the 
Inventory pane (Name, Video ID, Transfer Status, and so on).

n When a Name sort is active, items with no information in the Name field are moved to the top of 
the window. Clips that contain a numerical entry in the first position of these fields are sorted 
next, followed by all remaining clips sorted alphabetically by name.
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2. Click on the column heading again to reverse sort the items in the column.

The following table describes how the columns are sorted. 

Sort Category  

Option Description

Name Clips are sorted alphabetically by name. 

Video Id Clips are sorted alphabetically by a unique ID for the clip.

Duration Clips are sorted numerically by their length.

In Clips are sorted numerically by their In point.

Out Clips are sorted numerically by their Out point.

Creation Date Clips are sorted by the date they were recorded or transferred in.

Protected Clips are sorted alphabetically by those that are protected.

Format Clips are sorted alphabetically by format.

Transfer Status Clips are sorted alphabetically by their transfer status.

Proxy Status Clips are sorted alphabetically by their proxy status.
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Showing or Hiding Columns in the Inventory Pane

The Remote Console enables you to show or hide columns in the Inventory pane. 

n If you want to see the master clip name associated with a subclip, you must show the Original 
column.

To show or hide columns in the Inventory Pane:

1. In the Inventory pane, right-click on a column heading.

The following menu opens:

2.  Do the following to show or hide columns in the Inventory pane.

t To hide only the column pertaining to the column heading you right-clicked on, select 
Hide This Column.

t To display a column, select the option next to the column heading you want to display. It 
will appear in the Inventory pane.

t To hide a column, deselect the option next to the column heading you want to hide. It 
will not appear in the Inventory pane.
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3. To select or deselect multiple columns that you want to show or hide in the Inventory pane, 
do the following: 

a. Click the More button. 

The Choose Columns to Display dialog box opens. 

b. Select the columns you want to display (these will be checked) in the Inventory pane. 

c. Click OK to save your changes.

Filtering on a Clip Name or Video ID

This topic contains information on filtering on a clip name or video ID.

To filter on a clip name or video ID:

1. Type a portion or the full clip name or video ID you want to filter on in the Filter field to run 
the filter.

2. (Option) If you want to change the default filter settings, you can also right-click on the 
Filter field to bring up the Filter menu controls as shown in the following illustration:
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The following table describes the options available in the Filter menu.

3. (Option) If you want to filter clips based on whether they were recorded from baseband 
(locally) or transferred from a Send to Playback or FTP sequence, do one of the following:

t If you want the filter to only show clips that were recorded locally, select the Recorded 
option.

t If you want the filter will only show clips that were transferred from Send to Playback 
or FTP, select the Transferred option.

Filter Options  

Option Description

All This is the default. If selected, whatever you type in the Filter field 
applies to both video IDs and clip names.

Video ID If selected, whatever you type in the Filter field applies to Video IDs 
only.

Name If selected, whatever you type in the Filter field applies to clip names 
only.

Case sensitive If selected, whatever you type in the Filter field must be case sensitive for 
the filter to find a match. 

For example, if you typed “Dog”, it would not find “dog”, and vice versa.

Case insensitive This is the default. If selected, whatever you type in the Filter field does 
not need to be case sensitive for the filter to find a match. 

For example, if you typed “Dog”, it would also find “dog”, and vice 
versa.

Use wild cards This is the default. If selected, you can type wildcards such as * in the 
Filter field to find everything that contains the text after the wildcard. 
This field is redundant if Match anywhere is selected. For example, if 
you typed “*Do”, it would not find all names or Video IDs (or both) with 
the letters “do”, assuming you have Case sensitive selected.

Match from start If selected, whatever you type in the Filter field must be found at the 
beginning of the name or Video ID for the filter to find a match.

Match exactly If selected, whatever you type in the Filter field must be exactly the same 
as the name or Video ID for the filter to find a match. In other words, the 
whole name must be typed in exactly as it appears in the Inventory Pane.

Match anywhere This is the default. If selected, whatever you type in the Filter field can be 
anywhere in the name or Video ID, and can also be a partial name.
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n If both or neither the Recorded and Transferred options are selected, there is no effect on the 
filter.

Viewing Clip Properties and Modifying Clip Behavior

The Remote Console enables you to view clip properties and modify clip behavior. 

To view and Modify Clip Properties:

1. In the Inventory pane, right-click on a clip.

The following menu opens:

n If the Create Proxy option does not appear in the menu, the H.264 Proxy Encode License is not 
activated on the server. You must purchase and activate the license as described in the AirSpeed 
5000 Administrator’s Guide.

2.  Select the Clip Properties option.

The Clip Properties Panel opens in the Inventory pane. For more information, see “Clip 
Properties Panel” on page 46.

3. View the properties for the selected clip. You can also do the following:

a. Select a Looping option for the clip. If you select Loop, you can also specify the number 
of times you want to loop the clip by typing a number in the times field.

b. Specify the Loop In time of the clip. This is the position in the clip where looping starts. 
You can change this position by typing directly in the field.

n Looping functionality is available for SD and DNxHD clips only. You cannot loop MPEG-2 HD 
clips.
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Playing Clips

This topic contains information on the methods on how to cue and play a clip on an AirSpeed 
5000 server channel.

There are two methods for cueing and playing clips:

• Cue and Play directly from the Current Video ID field

• Cue and Take via the Next Video ID field

n  Pre-cued clips get removed when another clip is dragged and dropped to the active window of 
the same channel. When a clip is dragged or cued to in the active channel location of the Remote 
Console user interface, it overrides any pre-cued clip and causes the pre-cued clips to be ejected.

Cueing and Playing Clips Directly from the Current Video ID Field

This topic contains information on how to cue and play a clip directly from the Current Video ID 
field on an AirSpeed 5000 server channel.

To cue and play a clip from the Current Video ID field:

1. Do one of the following: 

t Select a clip in the Inventory Pane to highlight it, then click and drag and drop it into the 
Current Video ID field.

The clip cues, but does not play.

t Type the Video ID of the clip in the Current Video ID field, and press Enter.

The clip cues, but does not play.

2. Click the Play button to begin playback.
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Cueing and Taking Clips via the Next Video ID Field

This topic contains information on how to cue and take (F12) a clip on an AirSpeed 5000 server 
channel via the Next Video ID field.

To cue and take a clip via the Next Video ID field:

t Do one of the following: 

- Select a clip you want to cue from the Inventory Pane to highlight it, then click and drag 
and drop it into the Next Video ID field.

Click the Take (F12) key to Take the clip to the Current Video ID field.

- Type the Video ID of the clip you want to cue in the Next Video ID field, and press 
Enter.

Click the Take (F12) key to Take the clip to the Current Video ID field.

The clip will automatically begin to play.

Recording Clips

There are a few basic methods in which to record or capture clips. This topic contains 
information on the methods used to record clips on an AirSpeed 5000 server channel including:

• Crash Recording Clips

• Cueing Clips for Record

• Recording Clips with Only a Video ID Specified (no Duration or Name)

• Recording Clips with Both a Video ID and Duration Specified

• Recording Clips with Only a Name Specified (no Duration or Video ID)

• Recording Clips with Only a Duration Specified (No Video ID or Name)

Crash Recording Clips

A Crash record is the ability to start a recording and instantly capture to a predetermined 
channel, without a predetermined end time. A Crash record uses the channel settings that were 
configured from the Record and Destination templates. 

n Clip names and Tape names are not required when performing a Crash record. 

To crash record a clip:

1. Click the Record button. 

The clip will record to the location specified on the active AirSpeed 5000 server for that 
channel.
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n If you do not type a name or ID for the clip, one will be generated as specified in the Record and 
Destination templates.

2. Click the Stop button when you want to stop the crash record of this clip.

Cueing Clips for Record

This topic contains information on how to cue a clip for record.

To cue a clip for record:

1.  Select the channel you want to record to by clicking on it.

2. Do the following:

a. Click in one of the editable fields (Name, Video ID or Duration).

b. (Optional) Type a clip name, Video ID or duration for the clip.

If no video ID, clip name, or duration has been entered for the clip, the clip will be 
assigned this information based on how the Default Template for the AirSpeed 5000 
server you are recording to was configured.

c. Press Ctrl+Enter to cue the clip for record. 

n To cancel the Record Cue, click the Stop button.

3. Click the Record button to record the cued clip. 

The clip will stop recording at the set duration. However, you can also stop the record by 
pressing the Stop button.

Recording Clips with Only a Video ID Specified (no Duration or Name)

This topic contains information on how to record a clip on an AirSpeed 5000 server channel with 
a Video ID, but no duration or name specified.

To record a clip with a Video ID and no duration specified:

1.  Select the channel you want to record to.

2. Type a name for the clip in the Current Video ID field, and press Enter.

3. Click the Record button.

4. Click the Stop button to stop the record at the desired duration.
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Recording Clips with Both a Video ID and Duration Specified

This topic contains information on how to record a clip on an AirSpeed 5000 server channel with 
both a Video ID and duration specified.

To record a clip with both a Video ID and duration specified:

1.  Select the channel you want to record to.

2. Type a name for the clip in the Current Video ID field.

3. Type a duration for the recording in the Duration field.

4. Click the Record button or press Enter.

Record will continue until the duration specified is met, and the clip will be unloaded from 
the channel.

Recording Clips with Only a Name Specified (no Duration or Video ID)

This topic contains information on how to record a clip on an AirSpeed 5000 server channel with 
a name, but no duration or video ID specified.

To record a clip with a name and no duration or video ID specified:

1.  Select the channel you want to record to.

2. Type a name for the clip in the Name field.

3. Click the Record button or press Enter.

4. Click the Stop button to stop the record at the desired duration.

Recording Clips with Only a Duration Specified (No Video ID or Name)

This topic contains information on how to record a clip on an AirSpeed 5000 server channel with 
only a duration specified (no video ID or name).

To record a clip with only a duration specified (no video ID or name):

1.  Select the channel that you want to record to:

2. Type a duration for the recording in the Duration field.

3. Click the Record button, or press Enter. 

Record will continue until the duration specified is met, and when the recording stops, the 
clip will be unloaded from the channel.
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Modifying Mark In/Mark Out Points for Clips in the Inventory Pane

This topic contains information on how to modify the Mark In and/or Mark Out points for clips 
in the Inventory Pane. This can also be done in the Playlist.

To modify the Mark In or Mark Out points for clips:

1. Click in the In or Out field for the clip you want to change the Mark In or Mark Out point 
for.

2. Type the new timecode in the field. 

The new Mark In or Mark Out will reflect the timecode you entered in the field.

Creating Subclips

This topic contains information on how to create subclips from a master clip.

To create subclips:

1. Right-click on any master clip in the Inventory pane, and select Create Subclip from the 
menu.

A new subclip is created in a new row in the Inventory panel.

2. (Optional) View the source master clip from which the subclip was created. You must show 
the Original column.

n The Original column lists the name of the master clip from which the subclip’s media was taken 
from.

For more information, see “Showing or Hiding Columns in the Inventory Pane” on page 57.

3. Edit the Mark In and Mark Out points of the subclip. For more information, see “Editing the 
In and Out Points of a Clip in the Proxy Viewer” on page 69.



Working with Clips

66

Working with Proxy Clips

This topic contains information on the method used to create proxy clips and view them in the 
Proxy Viewer. 

In order to generate Proxy clips, and subsequently view them in the Proxy Viewer, the following 
must be done:

• An H.264 Proxy Encode license must be activated on your server. This activates the Proxy 
feature, and enables the Proxy Viewer.

• Once the H.264 Proxy Encode feature is activated on your server, you must create the proxy 
clips in one of the following ways:

- (Automatic) Select the Proxy Enabled check box in the Record Templates page of the 
AirSpeed 5000 Management Console. This automatically creates proxy clips for all 
ingested clips. For more information, see the AirSpeed 5000 Administrator’s Guide.

- (Manual) Right-click on a clip in the database, and select Create Proxy. This creates a 
proxy version of the hi-res clip. If there already is a proxy, this re-creates a proxy. For 
more information on creating proxy clips this way, see “Manually Creating Proxy Clips” 
on page 66.

n The Proxy Viewer is only available when you are connected to an AirSpeed 5000 server. In 
addition, the Remote Console application must be installed on a Windows 7 Operating System.

For more information, see the following topics:

• “Manually Creating Proxy Clips” on page 66

• “Viewing Proxy Clips” on page 67

• “Creating Subclips Using the Proxy Viewer” on page 68

• “Editing the In and Out Points of a Clip in the Proxy Viewer” on page 69

Manually Creating Proxy Clips

With the H.264 Proxy Encode License activated, you can create a proxy from any hi-res clip at 
any time using the AirSpeed 5000 Remote Console. 

This functionality is helpful in the following scenarios:

• You are just starting to create proxy versions of hi-res clips, and have old hi-res clips for 
which you would like to create proxy versions

• You want to manually create proxies for only certain hi-res clips (not all ingested clips).
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To manually create proxy clips:

1. Right-click on a clip in the database, and select Create Proxy. 

The Confirm Create Proxy dialog box opens.

n If the Create Proxy option does not appear in the menu, the H.264 Proxy Encode License is not 
activated on the server. You must purchase and activate the license as described in the AirSpeed 
5000 Administrator’s Guide.

2. Select Yes to create the proxy. 

The Proxy Status column will show the status (Requesting, Transcoding, % Done, 
Complete) of the proxy clip as it’s being created. The status also appears in the Clip 
Properties panel in the Proxy Clip field.

3. View the proxy clip by right-clicking the clip, and selecting View Proxy from the menu. For 
more information, see “Viewing Proxy Clips” on page 67.

Viewing Proxy Clips

If you have the H.264 Proxy option activated, and have created proxy clips, you can use the 
Proxy Viewer to view the proxy clips. 

To view proxy clips:

t Right-click on any master clip with proxy in the Inventory pane, and select View Proxy 
from the menu. 

n A clip with no proxy will have the View Proxy option grayed out.
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The Proxy Viewer opens.

Creating Subclips Using the Proxy Viewer

This topic contains information on how to use the Proxy Viewer to create a subclip.

To create a subclip using the Proxy Viewer:

1. Edit the Mark In and Mark Out points of the clip as desired. For more information, see 
“Editing the In and Out Points of a Clip in the Proxy Viewer” on page 69.

2. Once you have edited the In and Out points of a clip, and are satisfied with the results, click 
the Create Subclip button. 

A new subclip is created in a new row in the Inventory panel.

n The Original column lists the name of the master clip from which the subclip’s media was taken 
from.

For more information, see “Showing or Hiding Columns in the Inventory Pane” on page 57.
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Editing the In and Out Points of a Clip in the Proxy Viewer

This topic contains information on how to edit the In and Out points of a clip in the Proxy 
Viewer.

n You can also change the Mark In and Mark Out points by typing them in the Inventory Pane as 
described in “Modifying Mark In/Mark Out Points for Clips in the Inventory Pane” on page 65.

To edit the In and Out points of a clip:

1. Open a clip’s proxy in the Proxy Viewer.

2. Use the Proxy Viewer buttons, keyboard shortcuts, or mouse scroll wheel to locate the spot 
where you want to set the In or Out point of the clip. 

The timecode will change to reflect the In or Out point of the clip.

3. When you are at the location you are looking for, do one of the following:

a. Click the Mark In button, or type I to mark the new In point of the clip.

b. Click the Mark Out button, or type O to mark the new Out point of the clip.

You will notice the duration of the clip changes in both the Duration field of the Proxy 
Viewer, and the Duration field in the Inventory panel. 

n If you changed the In point, the clip will play from the new In point, and cueing the clip will now 
cue to the new In point. If you changed the Out point, the clip will stop playing at the new Out 
point.

4. (Option) To modify the In point or Out point of the clip, repeat this procedure.

n For Proxy clips, the new Mark In to Mark Out duration will be represented by the green portion 
of the Proxy Viewer timeline.
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Deleting Clips

This topic contains information on how to delete a clip. You can only delete unprotected clips, 
and clips that are not being used. 

For more information, see “Protecting or Unprotecting Clips from Deletion” on page 70.

To delete a clip:

1. In the Inventory pane, click on a clip you want to delete.

2.  Press the Delete key. 

A dialog box opens, asking if you are sure you want to delete this clip. Click Yes to delete 
the clip. The clip will be deleted from the AirSpeed 5000 server and will not appear in the 
Inventory pane.

You can also select multiple clips for deletion. There are two methods for selecting multiple 
clips.

To delete individual non-consecutive clips:

t Ctrl+click and select individual non-consecutive clips, and press the Delete key.

To delete a series of clips:

t Shift+click and select multiple consecutive clips, and press the Delete key.

Protecting or Unprotecting Clips from Deletion

The Remote Console enables you to protect or unprotect clips from being deleted from the 
AirSpeed 5000 server. 

The Protected column toggles between Protected (box checked), to Unprotected (box 
unchecked).

n You can also select multiple clips to protect/unprotect at the same time.
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To protect or unprotect clips from deletion:

1. In the Inventory pane, click on a clip you want to protect or unprotect from being deleted. 
You can also:

t Ctrl+click to select individual non-consecutive clips.

t Shift+click to select multiple consecutive clips.

2.  Once your clip(s) are selected, right-click and select Toggle Delete Protect from the menu.

This changes the status of the clip in the Protected column. The clip will switch to the 
opposite behavior that it had when you selected it. For instance, if it was protected from 
deletion (box was checked), it will now be unprotected (box unchecked). If it was 
unprotected (box was unchecked), it will now be protected (box checked).

n You can also manually click the check box to toggle Delete Protect for individual clips.

Transferring Clips to Shared Storage

This topic contains information on how to transfer clips to Shared storage. 

n This option is only available in an Interplay Production environment.

To transfer clips to Shared storage:

1. In the Inventory pane, click on a clip you want to transfer to Shared storage. You can also 
select multiple clips at once:

t Ctrl+click and select individual non-consecutive clips.

t Shift+click and select multiple consecutive clips.

2.  Once your clip(s) are selected, right-click and select Transfer to Interplay from the menu.

The selected clip(s) will be transferred to Shared storage, and checked in to Interplay.

Transferring Clips to an Avid Editor (Standalone Mode)

If your site is configured in a Standalone mode, you can transfer clips directly to an Avid Editor. 
The clips will also be transferred into the local storage location configured in the Interplay 
Transfer Engine Configuration.

To transfer clips to an Avid Editor:

1. In the Inventory pane, click on a clip you want to transfer to an Avid Editor. To select 
multiple clips do one of the following:

t Press Ctrl and then click to select individual non-consecutive clips.

t Press Shift and then click on the last clip of a group to select multiple consecutive clips. 
All clips in between will be selected.
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2. Drag the selected clip(s) to the Editor bin.

You will be asked if you want to transfer Now or Later.

3. Select Now. 

The Transfer Status will show the clip transferring to Interplay.

Working with Playlists

The AirSpeed 5000 Remote Console allows you to enable Playlist View to create, edit, and 
execute Playlists on a per channel basis. 

n You can create Playlists for up to the total number of Playout channels on the selected AirSpeed 
5000 or AirSpeed Multi Stream server.

Once you enable the View Playlists mode of the AirSpeed 5000 Remote Console, you can create 
Playlists for the Remote Console channel by simply dragging and dropping clips from the 
Inventory pane into the desired Channel Playlists. 

n In the Playlist, you can mix SD and HD clips, as well as clips with different aspect ratios.

n A Playlist can support up to 24 hours of video, and up to 1000 clips.

• Create a Playlist for a channel and drag and drop clips from the Inventory pane to the 
Playlist

• Modify the contents of a Playlist while it is playing without interrupting playback

• Control behavior when transitioning between clips (follow on or pause)

• Loop and cue Playlists

• Save and Load Playlists to or from a file for sharing with other workstations or for later use

• Minimum event duration is 10 seconds

For more information regarding Playlists, see the following topics:

• Creating Playlists

• Basic Playlist Operations

• Working with Clips in the Playlist
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Creating Playlists

This topic contains information on how to create Playlists in the AirSpeed 5000 Remote 
Console.

To create Playlists:

1. Select Options > View Playlists.

The user interface refreshes and the Channel pane is vertically aligned along the left hand 
side of the screen. 

Empty Playlists appear to the right of each channel, and a check mark appears in the View 
Playlist menu item to indicate that the View Playlist mode is enabled. 

To return to the default mode, select Options > View Playlist again.

2. Drag and drop clips from the Inventory pane to the Playlist area. To position your clip(s) in 
the Playlist, drag the selected clips to the desired location (before or after) any other clips in 
the Playlist. 

The name field appears as “Untitled Playlist”.

t Press Ctrl and then click to select individual non-consecutive clips.

t Press Shift and then click on the last clip of a group to select multiple consecutive clips. 
All clips in between will be selected.

3. To change the Playlist name, type a new name over the existing “Untitled Playlist” name in 
the Name field and press Enter.



Working with Playlists

74

4. Save the Playlist by doing the following: 

a. Click on the Playlist Name pulldown menu and select Save. 

The Save dialog box opens.

b. Navigate to the location where you want to save the Playlist, and type a name for the 
Playlist file, and click the Save button.

 The Playlist is saved.

5. (Option) Once you have clips in your Playlist, you can now do the following:

t Perform basic tasks involving entire Playlists, such as opening, saving, looping, and 
taking control of a Playlist. For more information, see “Basic Playlist Operations” on 
page 74.

t Perform tasks related specifically to clips in the Playlist. For more information, see 
“Working with Clips in the Playlist” on page 76.

Basic Playlist Operations

Some basic Playlist operations are available when in the Playlist View mode:

• Opening Playlists

• Clearing Playlists

• Taking Control of a Playlist for a Channel

• Setting Loop Behavior in the Playlist

Opening Playlists

Once saved, Playlists can be opened again. This topic contains information on how to open 
previously created Playlists.

To open Playlists:

1. Click the Playlist Name pulldown menu, and click Open.

The Open dialog box opens.

2. Do the following:

a. Navigate to the location where the Playlist was saved.

b. Click on the name of the Playlist file you want to open.

c. Click the Open button.

The selected Playlist is opened into the Playlist View.
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Clearing Playlists

This topic contains information on how to clear Playlists.

n Before being allowed to clear, you must unload any Playlist on the channel by clicking the Stop 
button or pressing the E key.

To clear Playlists:

1. Click the Playlist Name pull-down menu, and select Clear.

The Clear Playlist dialog box opens.

2. Click OK.

The Playlist will be cleared from the channel. If the Playlist was previously saved, the file 
will still remain in the location it was previously saved to.

Taking Control of a Playlist for a Channel

This topic contains information on how to take control of Playlists for a given channel. When 
you take control of a Playlist for a channel, it means that only you can make changes to the 
Playlist. 

Users at another Avid AirSpeed 5000 Remote Console will see a Lock icon next to the Playlist 
Name pull-down menu that indicates that this Playlist is locked and in use by someone else. They 
will not be able to modify, cue, or play (if a clip is not already precued) any clips within the 
Playlist.

To take control of a Playlist for a channel:

1. Click the Playlist Name pulldown menu for a channel that you want to take control of, and 
select Take Control.

You now have sole control of this channel. Users at another Avid AirSpeed 5000 Remote 
Console will see a Lock icon next to the Playlist Name pull-down menu that indicates that 
this Playlist is locked and in use by someone else. 

2. Once you have control of the Playlist, you can work with clips within the Playlist. For more 
information, see “Working with Clips in the Playlist” on page 76.

n Another user can take control of the Playlist at any time.
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Setting Loop Behavior in the Playlist

This topic contains information on how to toggle the Playlist between Loop On and Loop Off. 

The default is set to “Off”.

To set loop behavior in the Playlist:

t Click the Loop button.

- If the button is Green, it indicates Loop On.

- If the button is Grey, it indicates Loop Off.

Working with Clips in the Playlist

This topic contains all the tasks that you can perform when working with clips in the Playlist. 
The following tasks are included:

• Reordering Clips within the Playlist

• Modifying Mark In/Mark Out Points for Clips in the Playlist

• Setting the Follow Behavior for Clips in the Playlist

• Deleting Clips from the Playlist

• Taking Control of a Playlist for a Channel

• Cueing a Playlist

• Cueing From a Specific Clip in the Playlist

• Playing Clips in the Playlist

• Pausing Clips in the Playlist

• Stopping and Unloading Clips in the Playlist

Reordering Clips within the Playlist

This topic contains information on how to reorder clips within the Playlist.

To reorder clips within the Playlist:

t Select a clip that you want to reorder in the Playlist, and drag it from one location and then 
drop it into the new location in the Playlist. 

Modifying Mark In/Mark Out Points for Clips in the Playlist

This topic contains information on how to modify the Mark In and/or Mark Out points for clips 
in the Playlist. This can also be done in the Inventory Pane.
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To modify the Mark In or Mark Out points for clips in the Playlist:

1. Click in the In or Out field for the clip you want to change the Mark In or Mark Out point 
for.

2. Type the new timecode in the field. 

The new Mark In or Mark Out will reflect the timecode you entered in the field.

Setting the Follow Behavior for Clips in the Playlist

This topic contains information on how to set the “Follow” behavior for clips in the Playlist. 
When selected for a clip or clips, it will automatically play the clip next in the Playlist.

To set the Follow behavior for clips in the Playlist:

t Click the check box in Follow column for the clip you want to have automatically play next 
in the Playlist.

t To set the Follow behavior for multiple clips in the Playlist, do the following:

a. Ctrl or Shift-click the clips you want to change the Follow behavior for.

b. Right-click in the Playlist.

c. Do one of the following:

t To enable follow behavior, select Enable Follow from the menu.

t To disable follow behavior, select Disable Follow from the menu.

The selected clips will change their Follow behavior to what was selected. 

n If the Follow check box is selected for these clips, the clip in the Playlist will automatically play. 

n If the Follow check box is unchecked, the clip will not automatically play. All playout stops, and 
you need to manually restart playout.

Deleting Clips from the Playlist

This topic contains information on how to delete clips from the Playlist.

To delete clips from the Playlist:

t Ctrl or Shift-click the clips you want to delete, and press the Delete key (or right-click, and 
select Remove Clip from the menu).

All selected clips will be deleted from the Playlist.
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Cueing a Playlist

This topic contains information on how to cue an entire Playlist on the channel.

To cue a Playlist on the channel:

t Select the Playlist you want to load to the channel, and click the Cue button.

The Playlist will automatically be cued to the first clip and loaded on the channel. This is 
indicated by the first clip row appearing highlighted yellow.

Cueing From a Specific Clip in the Playlist

This topic contains information on how to cue a specific clip in the Playlist to the channel.

To cue a specific clip in the Playlist:

1. Select the clip you want to load to highlight it in the Playlist, and do one of the following:

t Click the Cue button. 

t Right-click on the highlighted clip in the Playlist, and select Cue from the Cue menu.

The selected clip will be cued to the channel. This is indicated by the cued clip row for that 
clip appearing highlighted yellow, and the Clip Name and Clip ID appearing in the Channel 
Name and ID fields.

n If you multi-select a number of clips in the Playlist, the clip with the lowest clip number selected 
will be cued to the channel.

Playing Clips in the Playlist

This topic contains information on how to start playing cued clips in the Playlist.

To play clips in the Playlist:

t Do one of the following:

- Press the [F12] key.

- Press the Play button on the Channel control.

- Press the [Spacebar].

The clip that is cued in the Playlist will begin playing (the clip row will have a green 
background), and the next playable clip in the Playlist will be cued.

n If you are already playing a clip, and want to play the next one, press F12. The currently playing 
clip will eject and the cued clip will begin to play. Pressing the Play button will have no effect if 
the clip is already playing.
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Pausing Clips in the Playlist

This topic contains information on how to pause currently playing clips in the Playlist.

To pause currently playing clips in the Playlist:

t Do one of the following:

- Press the Pause button on the Channel control.

- Press the [Spacebar].

The clip that is played in the Playlist will be paused. Press the Play button or the Spacebar 
to resume playing the clip.

Stopping and Unloading Clips in the Playlist

This topic contains information on how to stop and unload currently playing clips from the 
Playlist.

To stop and unload currently playing clips from the Playlist:

t Do one of the following:

- Press the Stop button on the Channel control.

- Press the E key.

The currently playing clip will be stopped and ejected from the channel, and any clip that is 
cued will uncue.
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Performing an Edit While Capture (EWC) with Drag 
and Drop

If you are in a Team configuration, you can use the Edit While Capture with Drag and Drop 
workflow to edit in-progress clips as they are being recorded via the AirSpeed 5000 Remote 
Console Standalone. The clips will also be transferred into the shared storage location 
configured in the AirSpeed 5000 Management Console.

Before you can perform an Edit While Capture, your system must have been set up using a Team 
Configuration (Shared storage and no Interplay).

To perform an Edit While Capture (EWC) with drag and drop:

1. From the AirSpeed 5000 Remote Console, start a Record. For more information, see 
“Recording Clips” on page 62.

2. Once the recording has begun, drag and drop the in-progress recording from the AirSpeed 
5000 Remote Console into an Editor bin.

You will be asked if you want to transfer Now or Later.

3. Select Now. 

The media appears online about 45 seconds after the transfer is started, and you can start 
editing the clip.

n There is a possibility that the clip drag and dropped to your bin will remain in-progress well 
after the clip has completed transferring. In this case, you should navigate to the location 
specified on the Default Templates tab under the Master clip location drop down 
(\\<SystemDirector>\<Workspace>\Avid Masterclips) and import the .AAF file of the clip being 
transferred.  This clip will most likely be noted as <VideoID>_1.aaf in the folder. Importing this 
file will close out the in-progress clip in the bin.

n This behavior might occur in the event that the editor is constantly playing while a transfer to the 
bin is taking place. The editor consumes all necessary resources to achieve playback of all 
frames, which may prevent the bin from being updated upon completion of playback.

n Clips edited while in this in-progress state may encounter issues when being exported.  It is 
required that if you are editing with an in-progress clip, and plan to export the composition, that 
you consolidate the clip before the export is performed.
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Performing an Edit While Capture (EWC) with Auto 
Transfer

If you are in a Team configuration, you can use the Edit While Capture with Auto Transfer 
workflow to enable the AirSpeed 5000 server to capture directly to your shared storage 
workspace location configured in the AirSpeed 5000 Management Console. The metadata for 
these clips will also be transferred to the location defined in the Master clip location (Team) field 
in the AirSpeed 5000 Management Console.

Before you can perform an EWC with Auto Transfer, make sure that your system has been set up 
using the Team Configuration (No Interplay with Shared storage). 

Also, on the Inventory page in the AirSpeed 5000 Management Console, make sure of the 
following:

• In the “Default Ingest Destination” field, under the Inventory tab, make sure that the 
Destination template that is selected includes the workspace that you want to transfer the 
media to.

• In the Master Clip Location (Team) field, select the ISIS workspace for which you want the 
AAF file to be transferred to.

n It is recommended that the location you select for the master clip location matches the location 
you selected in the Workspace field of the Default Ingest Destination field in the Inventory tab of 
the AirSpeed 5000 Management Console.

To perform an Edit While Capture (EWC) with auto transfer:

1. From the AirSpeed 5000 Remote Console, start a Record. For more information, see 
“Recording Clips” on page 62.

2. Do one of the following to locate your clip:

t From Windows Explorer, locate the clip(s) you want to EWC, then drag/drop the .AAF 
file into the Avid editor bin. 

The clip will be imported and an in-progress clip will appear in the Avid editor bin. For 
more information, see Step 4, then continue this procedure on Step 5.

t From the Avid Editor, select File > Import.
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The Select Files to Import dialog box opens.

3. Navigate to the location that is specified in the Master Clip Location (Team) field in the 
Inventory tab of the AirSpeed 5000 Management Console.
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4. Do the following:

a. Highlight the .AAF file of the clip that you started to record.

b. Verify that the Video Resolution and Destination drive you are importing to is correct. 

c.  Click Open.

The .AAF file will be imported, and an in-progress clip will appear in the Avid editor bin.

n Clips edited while in this in-progress state may encounter issues when being exported.  It is 
required that if you are editing with an in-progress clip, and plan to export the composition, that 
you consolidate the clip before the export is performed.

n Any duration changes that result in the clip being longer than it was initially, result in captures 
stopped short, and so on. You need re-import these clips to close them out.

n If you are performing a Crash Record, make sure that you update the clip every hour to get the 
updated clip duration.

n When clips are deleted from the Editor bin, the media will also be deleted. However, the 
metadata (.AAF file) used to import the clip will remain. For best results, the .AAF files need to 
be manually managed on a regular basis.

5. When the capture completes, select File > Import (or right-click Import in the Avid editor 
bin).

6. Select the .AAF file again, and click Open to complete the master clip.

The completed master clip appears as follows:
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Importing .AAF Files into the Avid Editor (Macintosh 
Team Mode)

If you are in a Team configuration, on a Macintosh Editor, you can use this workflow to enable 
the AirSpeed 5000 server to capture directly to your shared storage workspace location 
configured in the AirSpeed 5000 Management Console. The metadata for these clips will also be 
transferred to the location defined in the Master clip location (Team) field in the AirSpeed 5000 
Management Console.

Before you can import .AAF files into the Avid Editor, make sure that your system has been set 
up using the Team Configuration (Standalone Transfer Engine with Shared storage). 

Also, on the Inventory page in the AirSpeed 5000 Management Console, make sure of the 
following:

• In the “Default Ingest Destination” field, make sure that the Destination template that is 
selected includes the workspace that you want to transfer the media to.

• In the Master Clip Location (Team) field, select the ISIS workspace for which you want the 
.AAF file to be transferred to.

n It is recommended that the location you select for the master clip location matches the location 
you selected in the Workspace field of the Default Ingest Destination field in the Inventory tab of 
the AirSpeed 5000 Management Console.

To import files into the Avid Editor

1. With an AirSpeed 5000 configured for Team Mode, begin a record. The .AAF is checked 
into the shared storage destination that you have configured.
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2. In the Media Composer bin, select File > Import and navigate to the .AAF file. The file is 
now available to edit in Media Composer and the duration will automatically update as the 
clip is captured.

n Clips edited while in this in-progress state may encounter issues when being exported.  It is 
required that if you are editing with an in-progress clip, and plan to export the composition, that 
you consolidate the clip before the export is performed.

n Any duration changes that result in the clip being longer than it was initially, result in captures 
stopped short, and so on. You need re-import these clips to close them out.

n If you are performing a Crash Record, make sure that you update the clip every hour to get the 
updated clip duration.

n When clips are deleted from the Editor bin, the media will also be deleted, only if you have 
selected “Delete associated maid files”. Even so,, the metadata (.AAF file) used to import the 
clip will remain. For best results, the .AAF files need to be manually managed on a regular basis.

3. Edit the clip. The resulting sequences are sent to playback.

4. When the capture completes, select File > Import (or right-click Import in the Avid editor 
bin).
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5. Select the .AAF file again, and click Open to complete the master clip.

The completed master clip appears as follows:



A Keyboard Shortcuts

The AirSpeed 5000 Remote Console contains keyboard shortcuts to help you perform certain 
tasks quickly. Some of these keys can be used in combination with the use of a mouse. 

The following types of keyboard shortcuts are available:

• Inventory Pane Keyboard Shortcuts

• Channel Keyboard Shortcuts

• Proxy Viewer Keyboard Shortcuts

• Playlist Keyboard Shortcuts
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Inventory Pane Keyboard Shortcuts

The following table describes the keyboard shortcuts that can be used when focus is on the 
Inventory pane.

Action Keyboard Shortcut

Select an AirSpeed 5000 
server that is already loaded

Press the Ctrl + 1-9 keys, where 1-9 indicates one of the AirSpeed 
5000 servers that is currently loaded.

Delete a clip Press the Delete key.

Move down one clip Press the Down arrow key.

Move up one clip Press the Up arrow key.

Page down Inventory list Press the Page Dn key.

Page up Inventory list Press the Page Up key.

Go to the bottom of the 
Inventory list

Press the Ctrl + End keys.

Go to the top of the Inventory 
list

Press the Ctrl + Home keys.

Open the Online Help. Press the F1 key.
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Channel Keyboard Shortcuts

The following table describes the available keyboard shortcuts when focus is in the Channels 
pane.

Action Keyboard Shortcut

Select a channel Press the 1-4 keys where 1-4 represent the Channel 
number in the Channels pane. 

Play or Pause a clip Press the Spacebar.

Pause Press the K key.

Eject /Stop Press the E key.

Fast forward Press the L key. Press repeatedly to shuttle forward at 2, 
4, 8, and 16 times normal speed.

Fast rewind Press the J key. Press repeatedly to shuttle in reverse at 2, 
4, 8, and 16 times normal speed.

Step frame forward continually (repeated 
single frame jog)

Press and hold the K key, then press and hold the L key.

Step frame reverse continually (repeated 
single frame jog)

Press and hold the K key, then press and hold the J key.

Step forward one frame at a time Press the K key, then press the L key.

Step in reverse one frame at a time Press the K key, then press the J key.

Go to the In point of the clip Press the Alt + I keys.

Go to the Out point of the clip Press the Alt + O keys.

Set an In point for the clip Press the I key.

Set an Out point for the clip Press the O key.

Clear the In point for the clip Press the D key.

Clear the Out point for the clip Press the F key.

Clear both the In and Out points for the 
clip

Press the G key.

Perform a Take Press the F12 key.

Precue a clip for Record Press the Ctrl + Enter keys. For more information, see 
“Cueing Clips for Record” on page 63.
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Proxy Viewer Keyboard Shortcuts

The following table describes the available keyboard shortcuts when focus is in the Proxy 
Viewer.

Open the Online Help. Press the F1 key.

Action Keyboard Shortcut

Action Keyboard Shortcut

Play or Pause a clip Press the Spacebar.

Pause Press the K key.

Step forward one frame at a time Press the L key.

Step in reverse one frame at a time Press the J key.

Go to the In point of the clip Press the Alt + I keys.

Go to the Out point of the clip Press the Alt + O keys.

Set an In point for the clip Press the I key.

Set an Out point for the clip Press the O key.

Clear the In point for the clip Press the D key.

Clear the Out point for the clip Press the F key.

Clear both the In and Out points for the 
clip

Press the G key.

Create a new Headframe Press the H key.

Go to a Headframe Press the Alt + H keys.

Create a sublip Press the Alt + S keys.
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Playlist Keyboard Shortcuts

The following table describes the available keyboard shortcuts when focus is in the Playlist.

Action Keyboard Shortcut

Play a clip Press the Spacebar or L key.

Pause a clip Press the Spacebar or K key.

Stop and Eject a clip Press the E key.

Perform a Take Press the F12 key.

Open the Online Help. Press the F1 key.
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